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SMS Overview

This section provides the following introductory information about SMS: 
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Understanding the Distribution Solution

How can you be sure that all workstation users are using the appropriate software
required by your enterprise? Microsoft SMS distributes installations to workstations to
ensure that all workstations are running on the correct software versions at any time.
An enterprise cannot rely on workstation users to update the most current software
versions of OneWorld.

The requirements for a OneWorld distribution solution include:
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This list of requirements narrows the possibilities of how you can use SMS for
OneWorld distribution to essentially two approaches. Script the installation using
operation system commands, or use the existing setup.exe.

Scripting the installation is not feasible for two reasons. The command processor for
Windows NT or Windows 95 is not powerful enough to write the required batch files.
Scripting the installation is similar to completely rewriting the current setup.exe and
does not fulfill the requirement of reusing existing code.

There are two uses of setup.exe in an SMS-managed OneWorld distribution. The first is
simply to execute setup.exe once for each workstation and allow setup.exe to perform
everything, including the file copy. The other is to use setup.exe only to perform the
logical functions, such as registry updates and license validation and allow SMS to
manage the distribution of files to the clients. By using setup.exe to execute everything
including the file copying, we loose the ability to balance the load across network
segments without creating numerous distribution servers and managing numerous
unique setup.inf files.

For these reasons, the only acceptable solution is to use SMS to manage a process that
copies the appropriate files for each workstation and executes setup.exe with the no
copy option.
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Benefits of Using SMS for OneWorld Client Installations

SMS satisfies the following basic requirements for managing OneWorld distribution: 
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Coexistence with Current Installation Code and Controls 

Because SMS can coexist with OneWorld’s current software installation controls, you
can choose to use SMS exclusively or use both SMS and OneWorld installation
controls. Coexistence with the current installation code allows J.D. Edward to maintain
coexistence of controls and minimizes the effort required for integration.

Scheduled Push Installations 

The current installation strategy for OneWorld requires the user to initiate an
installation. SMS reduces the need for user involvement by scheduling installations and
enabling an administrator to push an installation, rather than depending on the user to
initiate the action.

Configurability 

Because OneWorld is highly configurable, the installation utility must also be
configurable. SMS allows you choose how to best accomplish the installation. For
example, you can specify installation from different environments, such as pristine,
development, production.

Improved Scalability 

SMS is designed to be network-aware and is scalable to large enterprises. Any
distribution strategy or method that uses SMS can take advantage of this scalability.
SMS allows you to spread the load of a distribution across numerous workstations and
network segments without unnecessarily impacting them.
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Challenges of Using SMS for OneWorld Installations

SMS presents certain challenges for managing OneWorld distribution: 
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Subscription Groups of Workstations 

The SMS strategy for standard distribution is based on subscription groups of
workstations. Standard OneWorld installations are related to users rather than
workstations. SMS supports complex querying, which can bridge the gap between
subscription groups and user installations, and SMS also includes products that
administer databases and user accounts. These tools, however, substantially increase
the level of complexity and cost of using SMS. Rather than trying to bridge the gap
programmatically, J.D. Edwards relies on the administrator to create and maintain
subscription groups.

Complex Management System 

SMS is a complex management system with a fairly steep learning curve.

Environment Requirements 

SMS has stringent environment requirements. The primary site server should be a
server that is dedicated to SMS. See System Requirements for a complete description of
hardware and software requirements.

SQL Server 

SMS relies on an SQL server for data storage requirements. The SQL server is
installed, configured, and maintained independently from SMS. This means that an
SQL server database administrator must be available.
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System Requirements

The SMS configuration is flexible, so the actual requirements vary depending on the
particular configuration of the enterprise. Microsoft recommends that the primary SQL
server database be installed on a different machine than the primary site server. 

Primary Site Server 
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SQL Server Database to Support SMS 

The requirements vary with the environment. The requirements listed below are the
minimum requirements to install an SQL Server.
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OneWorld Distribution Requirements

For distribution of OneWorld, the primary OneWorld distribution server must: 
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Additional servers or machines configured as managed nodes may be necessary
depending on the scope of the enterprise. If additional machines are necessary to
balance the load of the distribution across machines and the network, those additional
distribution machines are not required to be Windows NT servers.
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Getting Started

To work with SMS, you must complete the following tasks:
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Reviewing the OneWorld Setup Executable

In comparison with many installation programs, the OneWorld setup executable is
complex, because OneWorld clients must be integrated in a complex operating
environment. SMS can simplify installation for the clients. However, the SMS
administrator must have a good understanding of setup.exe for success. 

To display the command line options for setup.exe, enter the following command from
a Windows command line:

_csetup.exe -h

The example on the following page illustrates the command line options for setup.exe.
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Understanding the OneWorld Program Flow for Client
Installation

The OneWorld client installation program, setup.exe, consists of the following two
programs: 

� ���������

� �	���������

You must understand how these programs work to distribute OneWorld to clients.

setup.exe 

Setup.exe is a short program. Regardless of command line options, when executed
setup.exe performs the following:
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The following graphic illustrates the internal processes and program flow for setup.exe:

Yes
Yes

Yes

No No

No

Read setup.inf and 
cache necessary 
variables

Parse for command 
line parameters

Error in 
parsing?

Silent 
Mode?

Run 
Interactive

Compare DLLs

Create _csetup.exe 
Process and 
execute

Control 
Transfer _csetup.exe

Are
\Misc\*.DLLs newer than 

\System32\*.DLLs?

DLLs
setup.exe

 in start jobs
machine

Exit

Exit

_csetup.exe 

_csetup.exe performs most of the client installation. _csetup.exe can be executed
directly from a command line, or _csetup.exe can be called by setup.exe. The same
command line options apply in either case.
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The following graphic illustrates the internal processes and program flow for
_csetup.exe.
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Creating an After-Distribution Batch File

OneWorld.bat is the batch file that executes the OneWorld client installation program
and returns the status to SMS. The name OneWorld.bat is arbitrary, and you can modify
the contents of the batch file. 

OneWorld.bat Commands 

The following table presents each command line of an example OneWorld.bat file:

ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

Command ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

Explanation
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

@echo off
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

Causes commands not to be displayed on screen

ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

if %OS% == Windows_NT set
var=%SYSTEMROOT%

ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

This is the first step in deciding where to place the
status.mif.  SMS requires that a status.mif file be placed in
the windows directory of the workstation.  The name of
the environment variable associated with this directory
depends on the OS type.  This line compares the OS
environment variable to the string Windows_NT; if this is
true, the value of a new variable, “var” receives the value
of the SYSTEMROOT variable, which in Windows NT
represents the windows directory

ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

if not %OS%==Windows_NT
set var=%WINDIR%

ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

This line sets “var” to the value of the WINDIR variable.
This occurs for all workstations that are not running
Windows NT.

ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

setup.exe –n –s –u JDE –p
PROD_A PROD

ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

This command line executes the OneWorld client setup
program.  These particular switches indicate that no files
are copied (–n), this is a silent install (–s), the user id is
JDE (–u), and the PROD_A package located in the PROD
pathcode should be used (–p).

ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

���	 ��	���������� ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

��	�� 
�� 	�
��	��	 �
 ����	��
�� ��� 

�	 
���

�	����	�	

ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

if errorlevel 1 goto FAIL ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

If setup.exe fails, the errorlevel returned is 1.  This line
instructs the batch file to continue at the :FAIL marker.

ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

if errorlevel 0 goto SUCCESSÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

If setup.exe succeeds, the errorlevel returned is 0.  This
line instructs the batch file to continue at the :SUCCESS
marker.

ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

:FAIL ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

The FAIL marker.
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ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

type failed.mif>
%VAR%\OneWorld.mif

ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

The contents of the file failed.mif are placed into a file
named OneWorld.mif in the windows directory, the
location of which is the value of the VAR variable.
OneWorld.mif will be passed to the SMS server to indicate
that the job failed on this workstation.  The textual
description contained in the mif file will show up in the
SMS event monitor.

ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

goto END
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

This line instructs the batch file execution to continue at
the :END marker.

ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

:SUCCESS
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

The :SUCCESS marker.

ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

type success.mif>
%WinDir%\OneWorld.MIF

ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

The contents of the file success.mif are placed into the file
named OneWorld.mif in the windows directory, the
location of which is the value of the VAR variable.
OneWorld.mif will be passed to the SMS server to indicate
that the job succeeded on this workstation.  The textual
description contained in the mif file will show up in the
SMS event monitor.

ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

goto END ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

This line instructs the batch file execution to continue at
the :END marker.

ÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑ

:END ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ
ÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑÑ

The :END marker.
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Creating a Status.mif File

A status.mif file is a text file that is sometimes generated by the installation program to
indicate the status of a package that is run on a client workstation. SMS requires any
program that distributes software to provide a status.mif file to SMS upon completion.
The status.mif file must contain specific information in a prescribed format. The client
portion of SMS, the Package Command Manager or PCM, periodically scans the
windows directory for .mif files that may have been created after a package is run on a
client workstation. When a .mif is found, the PCM passes the .mif file to the SMS
server to indicate the status of the package that was run. 

All installation programs for currently available Microsoft products have the ability to
generate a status.mif file. Many other third-party products also generate a status.mif
during installation. Regardless of the product being installed, SMS uses the same
minimum information to monitor the status of the package. Microsoft provides utilities
with SMS that you can use to create .mif files for installation programs.

The OneWorld setup.exe does not generate a status.mif file, so you must create one.
This following is an example of a status.mif file created through the OneWorld.bat file.
The following status.mif is returned to SMS when the OneWorld installation fails.
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START COMPONENT
  NAME = ”WORKSTATION”
  START GROUP
    NAME = ”ComponentID”
    ID = 1
    CLASS = ”DMTF|ComponentID|1.0”
    START ATTRIBUTE
      NAME = ”Manufacturer”
      ID = 1
      ACCESS = READ–ONLY
      STORAGE = SPECIFIC
      TYPE = STRING(64)
      VALUE = ”J.D.Edwards”
    END ATTRIBUTE
    START ATTRIBUTE
      NAME = ”Product”
      ID = 2
      ACCESS = READ–ONLY
      STORAGE = SPECIFIC
      TYPE = STRING(64)
      VALUE = ”OneWorld”
    END ATTRIBUTE
    START ATTRIBUTE
      NAME = ”Version”
      ID = 3
      ACCESS = READ–ONLY
      STORAGE = SPECIFIC
      TYPE = STRING(64)
      VALUE = ”B731”
    END ATTRIBUTE
    START ATTRIBUTE
      NAME = ”Locale”
      ID = 4
      ACCESS = READ–ONLY
      STORAGE = SPECIFIC
      TYPE = STRING(16)
      VALUE = ””
    END ATTRIBUTE
    START ATTRIBUTE
      NAME = ”Serial Number”
      ID = 5
      ACCESS = READ–ONLY
      STORAGE = SPECIFIC
      TYPE = STRING(64)
      VALUE = ””
    END ATTRIBUTE
    START ATTRIBUTE
      NAME = ”Installation”
      ID = 6
      ACCESS = READ–ONLY
      STORAGE = SPECIFIC
      TYPE = STRING(64)
      VALUE = ”DateTime”
    END ATTRIBUTE
  END GROUP
  START GROUP
    NAME = ”InstallStatus”
    ID = 2
    CLASS = ”MICROSOFT|JOBSTATUS|1.0”
    START ATTRIBUTE
      NAME = ”Status”
      ID = 1
      ACCESS = READ–ONLY
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      STORAGE = SPECIFIC
      TYPE = STRING(32)
      VALUE = ”Failed”
    END ATTRIBUTE
    START ATTRIBUTE
      NAME = ”Description”
      ID = 2
      ACCESS = READ–ONLY
      STORAGE = SPECIFIC
      TYPE = STRING(148)
      VALUE = ”OneWorld installation failed.  Check c:\jdeinst.log for
details.”
    END ATTRIBUTE
  END GROUP
END COMPONENT

The .mif that is passed when the installation succeeds is the same as the one above,
except for the section for the completion status. Below is the InstallStatus group for a
successful OneWorld installation.

START GROUP
    NAME = ”InstallStatus”
    ID = 2
    CLASS = ”MICROSOFT|JOBSTATUS|1.0”
    START ATTRIBUTE
      NAME = ”Status”
      ID = 1
      ACCESS = READ–ONLY
      STORAGE = SPECIFIC
      TYPE = STRING(32)
      VALUE = ”Success”
    END ATTRIBUTE
    START ATTRIBUTE
      NAME = ”Description”
      ID = 2
      ACCESS = READ–ONLY
      STORAGE = SPECIFIC
      TYPE = STRING(148)
      VALUE = ”OneWorld installation Succeeded.”
    END ATTRIBUTE
  END GROUP
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Working with SMS

To work with SMS for distribution of OneWorld packages, complete the following
tasks:

� ��
����
�
��� ��� ���������� �� ���

� �������� ��� ��� �
��
�� ��� ���	���
 ������ ����
��
����

� �������� ��� ��� ���

� ��������� ��� ��� ����� �������
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Understanding the Components of SMS

SMS uses packages and jobs for a variety of purposes in software installation. 

Packages 

A package is a set of files with instructions. SMS recognizes several types of packages.
A workstation package installs software to workstations and executes commands. A
workstation package must include the source directory that is copied and the command
to execute on the workstation. The source directory includes all files and subdirectories
of a single directory tree. You cannot define multiple directories separately, nor can you
exclude certain directories.

Jobs 

After you have defined a workstation package, SMS uses a job to install the package to
one or more clients. The type of job that initiates the execution of a workstation
package is referred to as a Run Command on Workstation Job. The job defines the
machines on which to execute, when to execute, and conditions relating to the
execution, such as whether or not the job is mandatory.
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Defining the SMS Package for OneWorld Client Installation

The SMS Administrator tool allows you to open windows relating to packages, jobs,
and events. You create or modify properties of a package or job in the Job Properties
window. 

To define the SMS package for OneWorld client installation

On Microsoft SMS Administrator

1. From the View menu, choose Packages. 

2. From the File menu, choose New.
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3. On Package Properties, complete the following fields: 

� ��
�

� ��

���

The comment is a textual description that identifies the package to a user. Also,
notice that SMS assigns a unique package identifier when you create the
package. Use this unique identifier when troubleshooting.

4. Click the Workstations button.

5. On Setup Package for Workstations, complete the following field: 

� ���
�� �	
����
�

In this example, everything in the directory d:\packages\oneworld will be copied
to the client machine.

In this window the Command Line is only a descriptive name. Enter the details
of the Command Line in the Properties form.
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6. Click the Properties button.

7. On Command Line Properties, complete the following fields: 

� ����	�
 �	���

� ����	�
 �
���

The command line in this example executes the OneWorld batch file discussed
in Creating a OneWorld Batch File.

8. Click any of the following options: 

� �����	��
 ����	�
 �
��

� ��������
 ��	�������

Default access permissions associated with the Source directories are shown.

9. On Access, accept the default values and click OK.
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Defining the SMS Job

You can define types of jobs for different uses. Use the Run Command on Workstation
Job to install the package and execute a command. 

To define the SMS job

On Microsoft SMS Administrator

1. From the View menu, choose Jobs.

Use this window to monitor and modify jobs. The Jobs window displays all
existing jobs and parameters relating to those jobs. 

2. From File menu, choose New.
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3. On Job Properties, complete the following fields: 

� �
���	��

� �
� �
��

Notice that SMS assigns a Job ID. The Job ID is not the same as the Package ID.
In troubleshooting, the Job ID is probably more important, because the job
includes the package and corresponding characteristics.

4. Click the Details button.
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5. On Details, choose the package you want to install with the job. 

6. Click the following Job Target options:

� 
#� ' ��!#�"!

� 	������ � �#�

� 	������ ��"�

� ����" "� ��"�!

� ����#�� �#�!�"�!

The job target may be any combination of methods to indicate the machine(s) on
which to run the command. This example uses the results of an existing SQL
query named Computers by Name. This query allows you to name specific
machines to which to distribute. For additional options, see the recommended
reading listed at the beginning of this document.

7. Click one of the following Send Phase options:

� ���' �� 
�" � �$��#!�' ���"

� �$�� �� � �$��#!�' ���"

The Send Phase options enable the administrator to indicate whether the files
should be sent whether or not the files have been previously sent.

8. Click one of the following Distribute Phase options:

� ��� �!� �&�!"��� ��!" ��#"��� �� $� !

� �#" �� ��������� ��!" ��#"��� �� $� !

When you click the Put on Specified Distribution Servers option, define the
servers on which the package should be distributed.

9. Click any of the the following Run Phase Options and click OK:

� �#� �� �!"�"��� �������

� ���� ��"� 

� 	����"� ' ��"� 

� 
�" 	����"� ' �$� ���% ����

� �&�� �! ��"� 

You must enter timing options for distribution. Run Phase Options define when
the package should be first made available, whether the package is mandatory,
and whether the package is no longer available. An option indicating whether or
not the job is mandatory over a “Slow Link” can be used to prevent this job from
running over network segments that the administrator has identified as slow.

After defining job details, you are returned to the Job Properties form.
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10. On Job Properties, click the Schedule button.

11. On Job Schedule, complete the following fields: 

� �
��
 ��
��

� ��	
�	
�

� �����


In addition to a Start After time, you can indicate the job priority and the
conditions for which to repeat the job. Priority indicates how soon after the job
is created that the job will be made available to the targets. In the event that a job
is unsuccessful, use the repeat parameter to indicate how often SMS should
attempt to repeat the job.
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Reviewing the SMS Event Monitor

The SMS event monitor is similar to the Event Monitor packaged with Windows NT.
The SMS event monitor is useful when troubleshooting. The event monitor contains
details that are not shown in the status of jobs. The Events window lists events that
SMS has recorded. Oldest events are listed at the top of this list. 

To review the SMS event monitor

On Microsoft SMS Administrator

1. From the View menu, choose Events. 

2. To view additional detail for an event, double-click on the event.
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This example illustrates an event when a job failed to distribute the OneWorld
package to a workstation. A split window displays SMS general information
regarding the event and any detailed information that the event generated. In the
case of a Run Command on Workstation Job, the status.mif file contains a
textual description of the execution status of the job for each workstation. The
lower section of the window displays the description passed as part of a failed
OneWorld installation. Notice that the detail of the failure is limited. Rather than
making modifications to the existing setup.exe program that provides SMS with
detailed textual errors, the example passes the message to check the jdeinst.log
in the case of a failure. 
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